
Khi đọc qua tài liệu này, nếu phát hiện sai sót hoặc nội dung kém chất lượng 
xin hãy thông báo để chúng tôi sửa chữa hoặc thay thế bằng một tài liệu cùng 
chủ đề của tác giả khác. Tài liệu này bao gồm nhiều tài liệu nhỏ có cùng chủ 
đề bên trong nó. Phần nội dung bạn cần có thể nằm ở giữa hoặc ở cuối tài liệu 
này, hãy sử dụng chức năng Search để tìm chúng. 

Bạn có thể tham khảo nguồn tài liệu được dịch từ tiếng Anh tại đây:

http://mientayvn.com/Tai_lieu_da_dich.html

Thông tin liên hệ: 

Yahoo mail: thanhlam1910_2006@yahoo.com

Gmail: frbwrthes@gmail.com



 

 

Hướng dẫn định dạng tài liệu 

trên phần mềm Word 2003 theo 

mẫu của Nhà xuất bản Giáo dục  
  



Dưới đây là hướng dẫn định dạng tài liệu trên phần mềm Microsoft Word 

2003 theo mẫu của Nhà xuất bản Giáo dục: 

 

 

 

Hình ảnh chỉ mang tính chất minh họa 

  

Trước hết, chúng tôi sẽ hướng dẫn các bạn định dạng toàn bộ tài liệu sử dụng số đo 

là cm (trường hợp máy tính của bạn đã định dạng rồi thì bỏ qua bước này) bằng 

cách vào menu Tool chọn Options, trong bảng thoại Options chọn tab General. 

Trong mục Measurement units click chọn Centimeters rồi nhấn OK (xem hình 

dưới) 



  

 

  

Tiếp theo, các bạn vào menu File chọn Page Setup, trong bảng thoại Page Setup 

chọn tab Peper. Trong Paper size chọn Custom size chọn Width là 17cm, Height 

là 24cm (như hình dưới): 

  



 

  

Việc căn lề theo mẫu chắc hẳn bạn đã làm được (chọn Tab Margins và đặt đúng 

kích thước theo yêu cầu), ở trên chúng tôi chỉ hướng dẫn các bạn cách định dạng 

khổ giấy. 

  

Để chọn bước Tab cho toàn bộ văn bản là 0,75cm theo yêu cầu. Bạn chọn Menu 

Format chọn Tab trong mục Default tab stops đánh số 0.75cm rồi nhấn OK (như 

hình dưới) 

  



 

  

Chúc các bạn thành công ! 

 



Tạo tiêu đề trang (Header) 

và chân trang (Footer) trong 

Microsoft Office Word  
Bài viết sau đây sẽ hướng dẫn bạn tạo tiêu đề đầu trang (header) và chân 

trang (footer) trong MS Word 2003. 

1. Vào View \ Header and Footer 

 

=> Xuất hiện thanh cộng cụ Header and Footer 



 

2. Nhập nội dung tiêu đề trang & chân trang. Chi tiết chức năng về thanh công cụ 

Header và Footer như sau: 

Insert Auto text: Chèn nội dung tự động 

- - PAGE - : - Chèn số trang – 

- Author, Page #, Date: Chèn tên máy tính, số trang, ngày tháng năm (lấy theo 

ngày hiển thị trên máy tính). 

- Confidential, Page#, Date: Chèn Confidential, số trang, ngày tháng năm. 

- Created by: Hiển thị “Created by: tên máy tính” 

- Created on: Hiển thị “Created on: ngày, tháng, năm, giờ” (ngày thiết lập máy 

tính) 

- Filename: Tên file 

- Filename and path: Đường dẫn của file và tên file 

- Last Printed: Hiển thị “Last printed ngày, tháng, năm, giờ”. (ngày thiết lập máy 

in) 

- Last saved by: Hiển thị “Last saved by tên đặt khi cài windows”, 

- Page x of y: Trang thứ x trên tổng số y trang của file. 



 - Chèn số trang 

 - Chèn tổng số trang của file 

 - Tự đánh số trang bắt đầu tùy thích. 

 - Chèn ngày, tháng, năm (tính theo ngày hiện tại trên máy tính) 

 - Chèn giờ hiện tại trên máy tính 

 - Định dạng lại kích thước header & footer và lề trang 

 - Ẩn / hiện nội dung file khi tạo nội dung header & footer 

 - Same as previous: Hiển thị nội dung header & footer giống file trước 

 - Di chuyển giữa Header với  Footer 

 - Quay lên trang trước trang hiện tại 

 - Hiển thị trang sau trang hiện tại 

 - Thiết lập một số tính năng khác cho thanh công cụ Header and Footer. 

Trường hợp muốn có đường gạch ngang cùng với nội dung Header & Footer, bạn 

hãy dùng thanh vẽ của MS Word là Drawing như bình thường, vẽ một đường 

ngang ở vị trí phù hợp (ví dụ): 



 

Close: Thoát khỏi màn hình tạo header & footer. Sau khi tạo xong nội dung header 

& footer bạn có thể kích đúp chuột ra màn hình nội dung trang để thoát. 

* Trường hợp bạn muốn nhập nội dung Header & Footer của trang chẵn, 

trang lẻ khác nhau: 

1. Vào File \ Page Setup 

 

=> Xuất hiện hộp thoại Page Setup \ chọn thẻ Layout: 



 

2. Tại mục Headers and Footers: 

þ Different odd and even: Lựa chọn việc nhập nội dung Header & Footer của trang 

chẵn, trang lẻ khác nhau. 

þ Different first page: Lựa chọn việc nhập nội dung Header & Footer trang đầu tiên 

của file khác với mọi trang. 

3. Sau đó bạn nhập lại nội dung Header & Footer của trang chẵn, trang lẻ riêng. 

 



Một số chỉnh sửa cần thiết 

khi soạn thảo văn bản trên 

Microsoft Word 2003  
Trong quá trình soạn thảo văn bản, có một số lỗi mà bạn nên khắc phục ngay 

khi cài đặt xong phần mềm Microsoft Office. Bài viết sau đây sẽ hướng dẫn 

bạn khắc phục một số lỗi này: 

 

 

 



Trước hết bạn chọn Menu Tool\Option và click chọn thẻ General (như hình 1) 

Bỏ dấu tích dòng Automatically create drawing canvas when inserting 

AutoShape để khi sử dụng các công cụ vẽ Drawing sẽ không xuất hiện khung chọn 

trên màn hình, điều này đôi khi làm ta rất khó chịu. 

Trong hộp thoại Measurement units, click chọn đơn vị đo là Centimeters 

  

 

Hình 1 

  

 



Tiếp theo chọn thẻ Edit (như hình 2) 

Click bỏ chọn dòng Smart cut and paste nhằm mục đích khi gõ font Unicode sẽ 

khắc phục được tình trạng chữ bị cách khi gõ dấu. 

  

 

Hình 2 

  

Tiếp tục chọn thẻ Print (như hình 3) 



Click bỏ chọn dòng Backgound printing. Vì khi soạn thảo thường máy in của 

chúng ta là máy in đen trắng, nền màu trắng, loại bỏ dấu tích này sẽ giúp cho tốc in 

nhanh hơn. 

 

Hình 3 

Click chọn thẻ Spelling & Grammar (như hình 4) 

Click bỏ chọn 02 dòng: Check spelling as you type và Check grammar as you 

type (Sửa lỗi dấu chính tả và ngữ pháp tiếng Anh). Vì khi soạn thảo chúng ta gõ 



tiếng Việt, nếu để hai dòng này trên văn bản sẽ xuất hiện các dấu gạch chân màu 

đỏ và xanh rất khó chịu. 

 

Hình 4 

  

Click chọn thẻ File Locations (như hình 5) 

Click chọn nút Modify rồi chọn đường dẫn đến thư mục hoặc ổ đĩa mà bạn 

chuyên dùng để lưu trữ các file văn bản. Thông thường theo mặc định Word sẽ lưu 

file của bạn vào thư mục My Documents ở ổ C. Trường hợp bạn Ghost lại máy 



tính hoặc cài lại hệ điều hành, những file này sẽ bị mất. Tốt nhất chúng ta nên lưu 

trữ vào ổ đĩa không chạy hệ điều hành. 

  

  

Hình 5 

Bước tiếp theo, chọn Menu Fomat\Font hoặc nhấn tổ hợp phím Ctrl + D để mở 

hộp thoại Font (như hình 6) 

Tại hộp thoại Font bạn lựa chọn Font, Font style (kiểu chữ), size (cỡ chữ) rồi 

click nút Default để áp dụng cho tất cả các văn bản về sau. 



  

 

Hình 6 

Bước cuối cùng chọn Menu File Page Setup để chọn kích cỡ giấy 

Trong thẻ Paper bạn chọn khổ giấy A4. Tiếp theo trong thẻ Margin bạn chọn căn 

lề phù hợp với yêu cầu soạn thảo văn bản của bạn 

  



 

 



 

 

 

Word 2003: Thao tác cơ 

bản(P2)  



Thao tác cơ bản trên Word 2003  

Hiện nay do đa phần dân văn phòng vẫn sử dụng Word 2003, nên các thao 

tác cơ bản trên Word là rất quan trọng. Sau đây chúng tôi sẽ đưa ra một vài 

hướng dẫn cơ bản như sau: 

1. Đặt tab cho văn bản. 

Có thể hiểu nôm na rằng tab là cột mốc, tab cho phép bạn đặt mốc trái, trung 

tâm hay bên phải… Việc đặt mốc giúp cho bạn dễ dàng tùy biến nội dung 

văn bản hơn. Các tab được đặt trên thanh thước (Ruler) của Word, nếu màn 

hình bạn chưa có thước, bạn chọn menu View > Ruler. 



 

Ở góc trên bên trái của thước, Word hiển thị biểu tượng của tab, khi nhấp 

chuột vào bạn sẽ thấy biểu tượng này thay đổi. Các biểu tượng của tab như 

sau: 

-  : Tab canh trái. 

-  : Tab canh giữa. 

-  : Tab canh phải. 

-  : Tab canh dấu thập phân, tab này có tác dụng sẽ canh ngay điểm đặt dấu 

chấm (“.”) 

-  : Tab gạch đứng, khi đặt tab này sẽ tạo ra một đường thẳng trên màn hình 

soạn thảo. 

Để thay đổi tab đã đặt trên thước, chọn menu Format > Tab để hiển thị hộp 

thoại Tabs. 



 

Tại hộp thoại này, bạn có thể chèn thêm tab mới bằng cách nhập vị trí vào 

mục Tab stop position, chọn loại tab trong mục Alignment, phần Leader bạn 

chọn từ 1 đến 4 tùy thuộc theo kiểu muốn xuất hiện, xong nhấn Set. Để đồng 

ý tất cả bạn nhấn Ok để trở về màn hình soạn thảo. 

2. Đánh dấu chỉ mục cho văn bản: 

Để đánh dấu đoạn văn bản, Word cung cấp cho bạn 2 nút công cụ đánh dấu 

đó là đánh dấu ký hiệu  và đánh dấu bằng số thứ tự . 

Để thay đổi ký hiệu khác bạn vào menu Format > Bullets and Numbering, 

tại hộp thoại bạn chọn thẻ Bulleted. Trên thẻ này bạn chọn kiểu ưng ý, 

nhấp Customize để chọn thêm các kiểu khác, xong nhấp OK để chấp thuận. 



 

Để thay đổi kiểu số thứ tự, bạn cũng mở hộp thoại Bullets and Numbering, 

chọn thẻ Numbered, chọn kiểu số mà bạn thích, chọn Customize để điều 

chỉnh nội dung, xong nhấp OK. 

 

Với kiểu đánh số đầu dòng, bạn sẽ thường xuyên gặp hiện tượng số nhảy ra 

không như mong muốn, ví dụ số nhảy theo thứ tự từ các mục ở trên (mà 

không phải bắt đầu từ 1), hay bạn muốn tiếp tục với dãy số thứ tự ở trên. Khi 

đó bạn hãy dùng 2 nút. 

Với nút Restart numbering cho phép bạn đánh số lại từ đầu (bắt đầu bằng 1), 

trong khi nút Continue previous list cho phép bạn tiếp tục đánh số theo dãy ở 



trên. Hai nút này cũng có trên menu chuột phải, để hiện menu này bạn nhấp 

chuột phải vào số thứ tự đó, một menu sẽ hiện ra với biểu tượng số thứ tự đó 

được bôi đậm. 

 

3. Vẽ đường viền cho văn bản: 

» Để vẽ đường viền, bạn đặt con trỏ vào phần văn bản cần tạo đường viền, 

nhấp chuột vào biểu tượng Outside Border   trên thanh công cụ định dạng. 

» Để chọn các kiểu đường viền khác bạn nhấp vào nút  , một khung nhỏ sẽ 

hiển thị một loạt các kiểu đường viền như viền trên, viền dưới, viền trái hay 

phải. 

 

» Để vẽ đường viền cho một từ hay một câu, bạn dùng chuột chọn nội dung 

đó rồi thao tác như trên. 

  



» Nếu muốn thay đổi chi tiết về đường viền, bạn cũng chọn nội dung cần tạo 

viền rồi vào menuFormat > Border and Shading, tại hộp thoại hiện ra bạn 

chọn thẻ Border. 

 

» Tại mục này bạn có các tùy chỉnh: 

+ Setting: cho phép bạn chọn kiểu của viền như Box, Shadow… 

+ Style: Cho phép bạn chọn dạng nét viền. 

+ Color: Chọn màu cho viền. 

+ Width: Chọn kích cỡ viền. 

+ Preview: Xem trước kết quả. 

» Để tạo đường viền cho 1 trang, bạn cũng vào hộp thoại Borders and 

Shading, chọn thẻ Page Border, tại đây bạn chọn tương tự như trên, 

nhấp OK để đồng ý 



 

 



 
Cách chọn và thay đổi kiểu gạch dưới văn 

bản trong MS Word 2003 
 

Gạch dưới chữ là định dạng thường được sử dụng khi 
muốn nhấn mạnh một từ, cụm từ nào đó hoặc chỉ là đơn 
giản dùng để trang trí trong văn bản. MS Word cho phép 
chọn và thay đổi các kiểu gạch dưới khác nhau.  

Cách chọn và thay đổi các kiểu gạch dưới 

Dùng chuột đánh dấu (bôi đen) chữ, từ hoặc đoạn văn bản 
nào muốn gạch dưới hoặc thay đổi kiểu gạch dưới. 

 
Chọn Trình đơn Format -> Font 

Trong tab Font, nhấn vào mũi tên sổ xuống trong mục 
Underline style và chọn kiểu gạch dưới nào tùy ý. Trong 
đó (None) là không gạch dưới và Word only là chỉ gạch 
dưới các từ mà không gạch dưới các khoảng trống. 



 
Nhấn vào mũi tên sổ xuống trong mục Underline 
color sau đó dùng chuột nhấn vào các ô màu để thay đổi 
màu sắc cho đường gạch dưới. Trong đó Automatic là tự 
động chọn theo màu chữ, More Colors là chọn màu khác 
theo ý riêng. 

Sau khi chọn xong nhấn Ok để hoàn tất. 

Xem trong khung Preview để thấy được các thay đổi 
trước khi áp dụng kiểu gạch dưới 

 



 
Cách định khoảng cách lề cho văn bản trong 

MS Word 2003 
 

Canh lề (Margin) là tạo khoảng cách giữa các cạnh của 
trang giấy và các dòng chữ bên trong, nó sẽ giúp cho phần 
trình bày trang được đẹp và không bị mất chữ khi in. 
Word cho phép thay đổi kích thước lề giấy rất đa dạng, có 
thể thiết lập cho từng trang khác nhau trong cùng một tập 
tin văn bản. 

Định khoảng cách lề cho văn bản 

Truy cập vào Menu File và chọn Page Setup 

Trong Page Setup, chọn tab Margins sau đó thiết lập 
khoảng cách lề trong mục Margins như sau: 

 Top: Lề phía trên, khoảng cách từ cạnh giấy phía trên 
đến dòng chữ đầu tiên. 

 Bottom: Lề phía dưới, khoảng cách từ cạnh giấy phía 
dưới đến dòng chữ cuối cùng. 

 Left: Lề bên trái, khoảng cách từ cạnh giấy bên trái 
đến chữ đầu tiên bên trái. 

 Right: Lề bên phải, khoảng cách từ cạnh giấy bên 
phải đến chữ cuối cùng bên phải. 

 Gutter: Là phần gáy sách, phần này thường chỉ dùng 
khi cần đóng sách. 



Sau khi thực hiện xong nhấn Ok để đồng ý. 

 
Thiết lập kích thước lề mặc định chon văn bản 

 Nếu muốn sử dụng khoảng cách lề giấy này làm 
chuẩn mặc định trong tất cả các văn bản từ nay về sau 
thì cũng thực hiện các bước như trên nhưng sau khi 
thực hiện xong thì nhấn vào nút Default. Khi xuất 
hiện hộp thông báo thì nhấn Yes để đồng ý. 

 
 Có thể thay đổi khoảng cách lề giấy bất cứ lúc nào 

tùy ý nhưng nên thực hiện trước khi định dạng 
(Format) cho nội dung văn bản. 

 Khoảng cách lề giấy có thể được thiết lập khác nhau 
cho từng trang trong cùng một văn bản 

 



 
Cách kiểm tra bố cục trình bày văn bản 

trước khi in trong MS Word 2003 
 

Kiểm tra văn bản là công việc cần phải thực hiện trước 
khi in để tránh những sai sót về bố cục và trình bày nội 
dung. Chức năng Print Preview trong MS Word sẽ cho 
phép xem trước bản in để giúp người sử dụng kiểm tra và 
chỉnh sửa khi cần thiết. 

Cách xem lại văn bản trước khi in 

 Trong qua trình soạn thảo văn bản, người sử dụng có 
thể xem trước bản in bằng cách nhấn vào nút công cụ 
Print Preview  

 
 Hoặc truy cập vào trình đơn File và chọn Print 

Preview. 



 
Trong cửa sổ Print Preview có các nút công cụ với các 
chức năng sau 

 
1. Print: Nhấn vào nút này để thực hiện nhanh lệnh in 

tất cả các trang văn bản ra máy in. 
2. Magnifier: Công cụ phóng to, được mặc định chọn 

sẵn trong chế độ Print Preview. Khi công cụ này 
được chọn thì con trỏ chuột sẽ chuyển thành hình 
kính lúp có dấu +, muốn phóng to chỗ nào thì di 
chuyển kính lúp vào trị trí đó và nhấn chuột, nhấn 
tiếp một lần nữa sẽ thu nhỏ lại. 

3. One page: Chức năng này cho phép xem toàn bộ một 
trang văn bản. 



4. Multiple Pages: Chức năng này cho phép xem cùng 
lúc nhiều trang văn bản. 

5. Zoom: Công cụ giúp phóng to/ thu nhỏ trang văn bản 
theo tỉ lệ tùy chọn để xem cho rõ. 

6. View Ruler: Hiển thị hoặc ẩn thước đo. 
7. Shrink to Fit: Thu nhỏ chữ lại cho vừa trang giấy, 

mỗi khi nhấn vào nút này một lần thì kích thước Font 
chữ sẽ được giảm nhỏ để bớt một trang giấy, nhấn 
bao nhiêu lần thì sẽ giảm bấy nhiêu trang. 

8. Full Screen: Xem trong chế độ toàn toàn hình, các 
thanh công cụ không cần thiết sẽ được ẩn đi. Nhấn 
vào nút Close Full Screen để quay lại màn hình Print 
Preview thông thường. 

9. Close: Đóng màn hình Print Preview để qua trở lại 
màn hình soạn thảo. 

 Các chức năng trong màn hình Print Preview chỉ 
dùng để hỗ trợ xem trước khi in chứ không làm thay 
đổi bất cứ gì trong văn bản. Ngoại trừ chức năng 
Shrink to Fit sẽ làm giảm nhỏ kích thước Font chữ 
của toàn bộ văn bản theo tỉ lệ thu nhỏ được chọn. 

 Có thể nhấn vào nút Magnifier để đổi hình kính lúp 
thành dấu nháy để chỉnh sửa văn bản ngay trong màn 
hình Print Preview 

 

 



 
Cách lưu văn bản đã soạn thảo hoặc 

chỉnh sửa trong MS Word 2003 
 

Văn bản sau khi được tạo mới hoặc chỉnh sửa thì cần phải được 
lưu (Save) lại. Việc lưu văn bản sẽ giúp cho người sử dụng dễ 
dàng mở ra và sử dụng lại khi cần thiết. Mặc định các tập tin văn 
bản của MS Word sẽ được lưu trong thư mục My Documents. 

Cách lưu văn bản 

 Khi muốn lưu văn bản, có thể nhấn vào nút công cụ Save  

 

 Hoặc truy cập vào trình đơn File và chọn Save. 

 Nếu đây là lần đầu tiên lưu văn bản thì sẽ xuất hiện hộp 
thoại để chọn Thư mục và đặt tên cho tập tin văn bản cần 
lưu. Sau khi chọn xong nhấn Save để hoàn tất. 

Cách lưu văn bản đang soạn thảo thành một tập tin khác 



 MS Word có chức năng cho phép người sử dụng lưu văn 
bản đang soạn thảo thành một tập tin văn bản khác bằng 
cách truy cập vào trình đơn File và chọn Save as... sau đó 
tiếp tục thực hiện việc chọn thư mục và đặt tên khác cho 
tập tin văn bản như cách lưu thông thường. 

 

 Theo mặc định, Word thường lấy câu đầu tiên trong văn 
bản để đặt tên cho tập tin, người sử dụng có thể lấy tên này 
hoặc xóa đi để đặt lại tên khác.  

 Trong khi lưu, nếu người sử dụng đặt tên cho tập tin trùng 
với tên đã có sẵn thì sẽ xuất hiện hộp thoại với các lựa chọn 
sau: 

  
1. Thay thế tập tin đã có sẵn bằng tập tin đang được lưu, 
nếu chọn lựa chọn này thì tập tin cũ sẽ bị xóa.  
2. Lưu với tên khác.  
3. Kết hợp các thay đổi vào trong tập tin đã có sẵn. Đây là 
chức năng đặc biệt giúp quản lý và theo dõi các thay đổi 



trong nội dung văn bản của Word, chức năng này sẽ được 
đề cập đến trong các bài viết khác. 

 Sau khi lưu nếu vẫn tiếp tục soạn thảo văn bản thì trước khi 
đóng cần phải lưu lại lần nữa để cập nhật các nội dung mới 
thêm vào. 

 



 
Cách sử dụng chức năng Undo và Redo hoặc 

Repeat trong MS Word 2003 

 

Chức năng Undo dùng để quay trở lại, khôi phục lại các 
trạng thái, thao tác đã thực hiện trước đó. Chức năng 
Redo giúp khôi phục lại những thao tác đã Undo. Nếu 
không có gì để Redo thì chức năng này sẽ trở thành 
Repeat, giúp lập lại thao tác vừa thực hiện thêm một lần 
nữa. 

Sử dụng chức năng Undo 

 Khi muốn khôi phục lại một thao tác vừa thực hiện 
thì có thể nhấn vào nút Undo trên thanh công cụ hoặc 
vào trình đơn Edit và chọn Undo. Phím tắt của chức 
năng này là tổ hợp phím Ctrl+Z. 

 

Sử dụng chức năng Redo 



 Nếu muốn thực hiện lại những thao tác đã Undo thì 
có thể nhấn vào nút Redo trên thanh công cụ hoặc 
vào trình đơn Edit và chọn Redo. Phím tắt của chức 
năng này là tổ hợp phím Ctrl+Y. 

Sử dụng chức năng Repeat 

 Nếu muốn lập lại thao tác vừa thực hiện thêm một lần 
nữa thì vào trình đơn Edit và chọn Repeat. Phím tắt 
của chức năng này là tổ hợp phím Ctrl+Y. 

 Tùy theo thao tác mà công cụ Redo và Repeat sẽ tự 
động chuyển đổi để phù hợp với nhu cầu sử dụng.  

 Bên cạnh nút Undo và Redo trên thanh công cụ còn 
có một trình đơn sổ xuống, trong đó có ghi lại các 
thao tác đã thực hiện. Người sử dụng có thể chọn 
Undo hoặc Redo đến thao tác nào tùy ý. 

 



Cách sử dụng công cụ Cut hoặc Copy và 
Paste trong MS Word 2003 

 

Chức năng Cut (cắt) dùng để cất dữ liệu (văn bản, hình ảnh,...) 
đang được chọn vào bộ nhớ. Copy (sao chép) dùng để lưu dữ 
liệu đang được chọn vào bộ nhớ. Paste là chức năng giúp lấy các 
dữ liệu đang được lưu vào bộ nhớ để chèn vào ngay vị trí của 
dấu nháy. 

Cách sử dụng công cụ Cut 

 Khi muốn cất dữ liệu (văn bản, hình ảnh,...) vào bộ nhớ, 
bạn hãy dùng chuột đánh dấu chọn dữ liệu này và nhấn vào 
nút Cut trên thanh công cụ hoặc truy cập vào trình đơn 
Edit và chọn Cut. Ngoài ra còn có thể nhấn nút phải chuột 
vào vùng chọn để chọn lệnh Cut từ trình đơn. Phím tắt của 
lệnh Cut là Ctrl+X. 

 

Sau khi thực hiện lệnh này, dữ liệu sẽ trong văn bản sẽ bị xóa. 

Cách sử dụng công cụ Copy 



 Khi muốn lưu dữ liệu (văn bản, hình ảnh,...) vào bộ nhớ, 
bạn hãy dùng chuột đánh dấu chọn dữ liệu này và nhấn vào 
nút Copy trên thanh công cụ hoặc truy cập vào trình đơn 
Edit và chọn Copy. Ngoài ra còn có thể nhấn nút phải 
chuột vào vùng chọn để chọn lệnh Copy từ trình đơn. Phím 
tắt của lệnh Copy là Ctrl+C. 

Sau khi thực hiện lệnh này, dữ liệu sẽ trong văn bản vẫn được 
giữ nguyên. 

Cách sử dụng công cụ Paste 

 Khi muốn chèn dữ liệu (văn bản, hình ảnh,...) từ bộ nhớ, 
bạn hãy đặt dấu nháy chuột tại vị trí cần chèn và nhấn vào 
nút Paste trên thanh công cụ hoặc truy cập vào trình đơn 
Edit và chọn Paste. Ngoài ra còn có thể nhấn nút phải 
chuột tại vị trí cần chèn và chọn lệnh Paste từ trình 
đơn. Phím tắt của lệnh Paste là Ctrl+V. 

 

Sau khi thực hiện lệnh Paste, dữ liệu sẽ trong bộ nhớ vẫn còn 
được giữ lại, bạn có thể tiếp tục thực hiện lệnh Paste nhiều lần 
để chèn dữ liệu vào các vị trí khác. 

 Chức năng Paste chỉ chèn dữ liệu được thực hiện bởi lệnh 
Cut hoặc Copy mới nhất.  

 Dùng chức năng Cut và Paste khi muốn di chuyển dữ liệu 
từ vị trí này đến vị trí khác.  

 Dùng chức năng Copy và Paste khi muốn sao chép dữ liệu 
từ vị trí này đến vị trí khác.  

 Các chức năng này có thể áp dụng cho việc di chuyển hoặc 
sao chép tất cả dữ liệu (bao gồm văn bản, hình ảnh, bảng 



biểu,...) giữa các chương trình khác với MS Word và ngược 
lại. 

 



 
Cách tạo trang văn bản mới trong MS 

Word 2003 
 

Mỗi khi mở chương trình MS Word, sẽ có một văn bản 
trắng mới được tạo sẵn và người sử dụng chỉ việc thực 
hiện công việc soạn thảo văn bản của mình. Ngoài 
ra Word 2003 cho phép người sử dụng tạo cùng lúc nhiều 
văn bản mới để thuận tiện trong công việc của mình. 

Các cách tạo trang văn bản mới 

Tạo nhanh văn bản mới: Nhấn vào nút công cụ New 
Blank Document 

Tạo văn bản có lựa chọn: Truy cập vào trình đơn (Menu) 
File và chọn New... 

 
Cửa sổ New Document xuất hiện với các lựa chọn sau: 



 
 Blank document: Tạo văn bản trắng. 
 XML document: Tạo văn bản dạng XML. 
 Web page: Tạo văn bản dạng trang web. 
 Email message: Tạo Email mới thông qua chương 

trình MS Outlook. 
 From existing document: Tạo văn bản mới từ văn bản 

đã có sẵn. 

 Khi khởi động thì mặc định MS Word cũng tạo sẵn 
một văn bản mới có tên là Document1 và nếu tiếp 
tục tạo thêm văn bản mới khác nữa thì sẽ được đặt 
tên là Document2,.... Người sử dụng có thể giữ 
nguyên hoặc thay đổi tên này khi lưu văn bản.  

 Phím tắt để tạo văn bản mới là Ctrl+n 

http://www.buaxua.vn | Xem thêm tại: 
http://www.buaxua.vn/Tin-hoc-van-phong/Cach-tao-
trang-van-ban-moi-trong-MS-Word-2003.html 
 



 

Cách thay đổi khoảng cách và co giãn 
chữ trong MS Word 2003 

 

Thay đổi khoảng cách và co giãn chữ trong soạn thảo văn bản có 
thể được xem như là kỹ thuật sắp chữ trong ngành in. Việc này 
không chỉ giúp trình bày trang văn bản đẹp mắt mà còn rất quan 
trọng trong bố cục toàn bộ bản in và phù hợp với số lượng trang 
in. 

Cách thay đổi khoảng cách và co giãn chữ 

Dùng chuột đánh dấu (bôi đen) chữ, từ hoặc đoạn văn bản nào 
muốn thay đổi. 

 

Chọn Trình đơn Format -> Font 

 

Vào Tab Character spacing. Trong phần này có các mục sau: 



 Scale: Kéo giãn hoặc co hẹp chữ theo một tỷ lệ, có thể 
chọn tỷ lệ có sẵn hoặc nhập một giá trị tỷ lệ % tùy ý. Tỷ lệ 
100% là bình thường, nhỏ hơn là co hẹp và lớn hơn là kéo 
giãn. 

 

 Spacing: Thay đổi khoảng cách giữa các chữ (bao gồm 
khoảng trống), trong đó: 

- Normal: Là khoảng cách bình thường. 

- Expanded: Là tăng khoảng cách chữ rộng ra theo kích thước 
được chọn trong mục By. 

- Condensed: Là giảm khoảng cách chữ hẹp lại theo kích thước 
được chọn trong mục By. 

 Position: Định vị trí chữ, trong đó: 

- Normal: Là khoảng cách bình thường. 

- Raised: Là nâng cao chữ lên theo khoảng cách được chọn 
trong mục By. 

- Lowered: Là hạ thấp chữ xuống theo khoảng cách được chọn 
trong mục By. 



(Mẫu 
thay đổi khoảng cách và co giãn chữ) 

Kerning for font là một tính năng giúp tự động điều chỉnh 
khoảng cách đồng đều giữa các chữ. Để sử dụng tính năng này, 
hãy chọn kích thước (cỡ) chữ nhỏ nhất muốn áp dụng trong mục 
Points and above. MS Word sẽ tự động điều chỉnh tất cả các 
Font chữ có kích thước đó hoặc lớn hơn. 

 Đơn vị đo kích thước mặc định là Point (pt: điểm ảnh) tuy 
nhiên bạn có thể nhập bất cứ đơn vị đo khoảng cách nào 
khác tùy ý (mm, cm,…). 

 Xem trong khung Preview để thấy được các thay đổi trước 
khi áp dụng kiểu gạch dưới 

 



 

 

 

 

Hướng dẫn tạo mục lục tự động 

trong Word 2003 
  



Tạo một mục lục tự động giúp bạn tiết kiệm thời gian và công sức bằng cách tận 

dụng những tiện ích có sẵn được nâng cấp thân thiện trong MS Word 2003. Bài viết 

sẽ hướng dẫn bạn thực hiện bằng những thao tác đơn giản nhất  

Việc tạo một mục lục bằng tay thì khá đơn giản song nó lại có rất nhiều nhược điểm như: 

rất khó khăn để tạo một mục lục với một văn bản dài tới cỡ hàng trăm trang, khi chúng ta 

có nhu cầu thay đổi lại bố cục bài viết hoặc chỉnh sửa thêm bớt ý thì lại phải chỉnh lại 

toàn bộ mục lục và số trang cho phù hợp. 

Do đó việc làm mục lục tự động sẽ giúp bạn tiết kiệm rất nhiều thời gian và công sức. 

Đầu tiên để tạo được mục lục thì các bạn phải đánh dấu heading cho mục lục trước đã. 

Click chuột vào dòng mà các bạn định chọn làm mục lục (chẳng hạn như: 1.1 Tổng quan 

về ...) các bạn chọn mục lục như sau: 

 

 

Hoặc có thể sử dụng phím tắt nếu bạn thích: 

- Alt + Ctrl + 1: Heading 1 (Đề mục 1) 

- Alt + Ctrl + 2: Heading 2 (Đề mục 2) 



- Alt + Ctrl + 3: Heading 3 (Đề mục 3) 

Từ Heading 4 trở đi sẽ không dùng tiếp được phím tắt như trên. Tuy nhiên có thể dùng tổ 

hợp phím Ctrl + Shift + S để vào hộp Style trên thanh Formatting, sau đó cùng phím mũi 

tên lựa chọn loại Heading. 

Ứng với mỗi loại heading là một loại mục lục: 

■ Heading 1: mục lục lớn nhất (thường dùng cho chương 1, chương 2...) 

■ Heading 2: mục lục lớn thứ hai (thường dùng cho 1, 2, ...) 

■ Heading 3: mục lục lớn thứ ba (thường dùng cho 1.1, 1.2, ...) 

Sau khi đã dánh dấu tất cả các heading cho các mục. Bạn tiến hành hiển thị mục lục như 

sau. 

1. Lựa chọn vị trí đặt mục lục: (Thường đặt ở cuối hoặc đầu văn bản) 

2. Vào Insert \ Reference \ Index and Tables… 

Trường hợp dùng Office 2000: Vào Insert \ Index and Tables… 

 

 

3. Xuất hiện hộp thoại Index and Tables, chọn thẻ Table of Contents 



 

 

■ Print Preview: Kiểu mục lục sẽ hiển thị khi in 

■ Web Preview: Kiểu mục lục sẽ hiển thị ở dạng trang web 

■ Show page numbers: Hiển thị số trang. 

■ Right align page numbers: Hiển thị số trang bên lề phải. 

■ Use hyperlinks instead of page numbers: Có sử dụng liên kết từ mục lục tới trang đặt 

Heading. 

■ Tab leader: Chọn loại đường tab từ cuối các Heading đến số trang. 

■ Show levels: Số cấp độ Heading. 

■ Nút Show Outlining Toolbar: Cho hiển thị thanh công cụ Outlining trên cửa sổ MS 

Word 

■ Nút Options…: Mở hộp thoại Table of Contents Options: Tùy chọn thêm một số tính 

năng khác. 



 

■ Nút Modify…: Mở hộp thoại Style, sửa đổi định dạng font chữ cho nội dung phần mục 

lục tự động. 

 



Trường hợp trong file đã có mục lục tự động, và bạn đồng ý thay đổi định dạng font chữ 

bằng hộp thoại Style sẽ xuất hiện thông báo: “Bạn có muốn thay thế định dạng cho bảng 

nội dung mục lục không?" 

 

Chọn nút Yes: Đồng ý. Ngoài font chữ của nội dung bảng mục lục thay đổi, MS Word 

còn tự động cập nhật lại số trang cho các đề mục. 

 

4. Kích và nút OK để MS Word hiển thị mục lục. 

 

 

Ở tại phần mục lục này, tự động có liên kết cho phép bạn click chuột (hoặc dùng kết hợp 

phím Ctrl + click chuột) để nhảy đến đúng mục và số trang cần đến. 



 

Trường hợp bạn thay đổi chỉnh sửa nội dung thì có thể update cho mục lục bằng cách 

click chuột phải vào phần mục lục và chọn "update". Mục lục sẽ tự thay đổi số trang và 

đề mục theo đúng sự thay đổi của bạn. 

 


